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FedEx Web Services 2021 –  
the new standard for FedEx Shipping
As part of our commitment to delivering a state-of-the-art shipping experience to you,  
we are ready to offer the latest 2021 version of FedEx Web Services, specifically designed 
to streamline and strengthen your operations. 

To benefit from the full range of FedEx capabilities, upgrading to the new version  
is mandatory.

3 key facts you need to know

Any older version of FedEx Web Services  
will no longer be supported

We’ve added features that will allow you to 
enhance your own operations and unlock new 
opportunities for your business

Upgrading will mean you benefit faster from 
our expanding range of services, such as our 
dedicated new economy and express services

This document will guide you through the required changes for updating your existing Web 
Services version to the current 2021 release of FedEx Web Services.
Not all features are covered in this guide. If you should encounter any issues or require further 
assistance, do not hesitate to contact your FedEx Customer Technology representative.
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FedEx Web Services 2021 – New Services
Benefit from a wider choice of delivery times with the new FedEx International Priority® 
Express and FedEx International Priority® services that replace the existing International 
Priority service.

Unlock the potential of our integrated network with the new FedEx® Regional Economy 
and FedEx® Regional Economy Freight services that will offer new opportunities for your 
parcel and freight shipments within Europe.

To enable the new services as from 3 January 2022, enter the following values into the 
<ServiceType> element of your Web Services request:

FEDEX_REGIONAL_ECONOMY	 FEDEX_INTERNATIONAL_PRIORITY
FEDEX_REGIONAL_ECONOMY_FREIGHT	 FEDEX_INTERNATIONAL_PRIORITY_EXPRESS
	 FEDEX_INTERNATIONAL_CONNECT_PLUS

You can discuss further the details of when you will be enabled to access the new service 
portfolio (FedEx Regional Economy and FedEx Regional Economy Freight , as well as  
FedEx® International Connect Plus) with your FedEx customer Technology or Sales representative.
Until the transition is completed, you can continue using our current services.
Only 2020 and 2021 versions of FedEx Web Services will support the new services.
To download the 2021 version (v28 ShipRequest) WSDL and the current Developer Guide, 
please visit the FedEx Developer Resource Center: www.fedex.com/us/developer.

FedEx Developer Resource Center
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Belgium

Czech Republic
Denmark

Estonia
Finland
France

Germany
Hungary

Ireland
Italy

Latvia
Lithuania

Luxembourg
Netherlands

Norway
Poland

Slovenia
Spain

Sweden
Switzerland

United Kingdom

FedEx® Regional Economy & FedEx® Regional Economy Freight Coverage

https://www.fedex.com/en-us/developer.html
https://www.fedex.com/en-us/developer.html
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Electronic Trade Documents
FedEx® Electronic Trade Documents (ETD) is the best way to exchange customs paperwork 
information with us. It allows you to transmit customs documentation electronically for  
your international shipments.

We strongly encourage FedEx customers who have not adopted this setup yet to make  
the transition as soon as possible.

Benefits of ETD

Save time when preparing your shipments: you no longer 
have to print, sign, fold and attach your trade documents 
to each shipment.

Minimise the risk of customs delays by allowing for a 
quicker documentation review: you are notified earlier of 
potential errors or missing paperwork.

Save money and reduce your carbon footprint: lower your 
consumption of paper and toner for your international 
shipments, as only one shipping label is required.
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Implementing ETD

Choose one of the following three processes for using ETD:

When one or both of the origin or destination countries do not accept paperless clearance, 
ETD will trigger the ‘Electronic with Original’ (EWO) option.
EWO is stated in the Shipment Reply of your XML request to FedEx, and it is also printed on 
the FedEx label. This makes it easy to identify when to trigger printing for IT systems. And for 
personnel, it means they know when to attach paperwork to their physical packages.
In this case, you can seamlessly upload your customs documents electronically to benefit from 
an early broker review, but you will still have to attach printed copies of customs documents to 
your shipment to comply with regulatory requirements.

Contact your FedEx CT representative for more details and guidance to optimise or 
implement ETD. 

You can also refer to FedEx Web Services | FedEx Developer Resource Center (you will need to 
be logged in first).

Option 1
 
 

Option 2 

 

Option 3

Let FedEx create the paperwork for you
This is ideal for simple shipping scenarios. FedEx can create a commercial 
or pro forma invoice and, where needed, a Certificate of Origin for you 
without the need for these documents to be printed.

Create the paperwork yourself and upload it  
before you print the label
This is ideal if your paperwork is available before you create the  
FedEx shipping label.

Upload the paperwork immediately after  
creating the FedEx shipping label
This is ideal for customers who use a complex process to generate the 
required documents and who are unable to produce the paperwork 
before or during the creation of their FedEx shipping label.

https://www.fedex.com/en-us/developer/web-services/process.html#AdvancedServices
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Technical changes for upgrading  
FedEx Ship Requests v7 to v28 (2021)

Endpoints
There are new endpoints – in the future use for 	
Production:	 https://ws.fedex.com:443/web-services/ship
Test:	 https://wsbeta.fedex.com:443/web-services/ship
The old endpoints are still working but will be decommissioned in the near future. 
Effective May 29, 2021, FedEx will no longer accept a security protocol below TLSv1.2 for any 
of our production web services gateway servers. After that date, any communication requests 
submitted to FedEx using a security protocol below TLSv1.2 will fail.

FedEx Label on A4 (PDF)
For customers creating FedEx labels in A4 (PDF), a new AWB format has been introduced for 
FedEx labels. Please hand all paperwork provided in the reply over to the courier. There are 
now two different formats in the reply, both are required for a complete FedEx shipment.

Pending Shipments
If you are creating pending shipments, please contact your CT representative, as this is not 
possible in the Ship Request of the current version (v28) anymore.

https://ws.fedex.com:443/web-services/ship
https://wsbeta.fedex.com:443/web-services/ship
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Necessary changes in specific elements  
of the FedEx Ship Request

<ServiceType>
As indicated previously in this document, the <ServiceType> options in your current solution 
must be adjusted as from January 3rd 2022 to accommodate the new FedEx Service types:
FEDEX_REGIONAL_ECONOMY	 FEDEX_INTERNATIONAL_PRIORITY
FEDEX_REGIONAL_ECONOMY_FREIGHT	 FEDEX_INTERNATIONAL_PRIORITY_EXPRESS
	 FEDEX_INTERNATIONAL_CONNECT_PLUS

<ShippingChargesPayment>
The <ShippingChargesPayment> element has been updated. <ResponsibleParty> has been 
inserted and is now mandatory.
<CountryCode> has become optional in the latest version and it is recommended to remove it, 
otherwise it must be embedded in the <Address> element.

Version 7 Version 28 (current)

<ShippingChargesPayment>
    <PaymentType>SENDER</PaymentType>
         <Payor>
             <AccountNumber>xxx</AccountNumber>
             <CountryCode>xx</CountryCode>
         </Payor>
</ShippingChargesPayment>

<ShippingChargesPayment>
               <PaymentType>SENDER</PaymentType>
            <Payor>
               <ResponsibleParty>
                  <AccountNumber>xxx</AccountNumber>
               </ResponsibleParty>
            </Payor>
</ShippingChargesPayment>

If you wish to preserve the <CountryCode>, you have to newly embed it into the 
<Address> element, however, it is not mandatory to submit <CountryCode>

<ShippingChargesPayment>
     <PaymentType>SENDER</PaymentType>
     <Payor>
       <ResponsibleParty>
       <AccountNumber>xxx</AccountNumber>
          <Address>
             <CountryCode>xx</CountryCode>
          </Address>
       </ResponsibleParty>
     </Payor>
</ShippingChargesPayment>
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<International Detail>
The <InternationalDetail> element was renamed to <CustomsClearanceDetail>. The nested 
tags have not changed, save for the optional element <RecipientCustomsIdType> that has 
been removed.

Version 7 Version 28 (current)

</ShippingChargesPayment>
     <InternationalDetail>
          <RecipientCustomsIdType>INDIVIDUAL</RecipientCustomsIdType>
               <DutiesPayment>
                  <PaymentType>RECIPIENT</PaymentType>
               </DutiesPayment>
               <DocumentContent>DOCUMENTS_ONLY</DocumentContent>
               <CustomsValue>
                  <Currency>UKL</Currency>
                  <Amount>80</Amount>
               </CustomsValue>
               <Commodities>
                  […]
               </Commodities>
               <ExportDetail>
                  <ExportComplianceStatement/>
               </ExportDetail>
     </InternationalDetail>
            <LabelSpecification>
               <LabelFormatType>COMMON2D</LabelFormatType>

</ShippingChargesPayment>
     <CustomsClearanceDetail>

               <DutiesPayment>
                  <PaymentType>RECIPIENT</PaymentType>
               </DutiesPayment>
               <DocumentContent>DOCUMENTS_ONLY</DocumentContent>
               <CustomsValue>
                  <Currency>UKL</Currency>
                  <Amount>80</Amount>
               </CustomsValue>
               <Commodities>
                   […]
               </Commodities>
               <ExportDetail>
                  <ExportComplianceStatement/>
               </ExportDetail>
      </CustomsClearanceDetail>
            <LabelSpecification>
               <LabelFormatType>COMMON2D</LabelFormatType>

<DutiesPayment>
The <DutiesPayment> element has been updated. <ResponsibleParty> has been inserted and 
is now mandatory.
Exception: If <PaymentType> is RECIPIENT in <DutiesPayment>, <ResponsibleParty>  
is optional.
<CountryCode> is optional in the latest version and it is recommended to remove it, otherwise 
it needs to be embedded in the <Address> element.

Version 7 Version 28 (current)

<CountryCode>DE</CountryCode>
               </Address>
            </Recipient>
<DutiesPayment> 
               <PaymentType>SENDER</PaymentType>
               <Payor>
                   <AccountNumber>xxx</AccountNumber>
                   <CountryCode>xx</CountryCode>
               </Payor>
</DutiesPayment> 

<CountryCode>DE</CountryCode>
               </Address>
            </Recipient>               
<DutiesPayment> 
               <PaymentType>SENDER</PaymentType>
               <Payor>
                 <ResponsibleParty>
                    <AccountNumber>xxx</AccountNumber>
                 </ResponsibleParty>
               </Payor>
</DutiesPayment>

If you wish to preserve the <CountryCode>, you have to newly embed it in 
the <Address> element, however, it is not required to submit <CountryCode>

<DutiesPayment> 
               <PaymentType>SENDER</PaymentType>
               <Payor>
                 <ResponsibleParty>
                   <AccountNumber>xxx</AccountNumber>
                     <Address>
                        <CountryCode>xx</CountryCode>
                     </Address>
                    </ResponsibleParty>
               </Payor>
</DutiesPayment> 
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<PackageDetail>
The optional <PackageDetail> element has been removed. It is no longer needed and there is 
no replacement.

Version 7 Version 28 (current)

<PackageCount>1</PackageCount>
            <PackageDetail>INDIVIDUAL_PACKAGES</PackageDetail>
            <RequestedPackageLineItems>
               <Weight>
                  <Units>KG</Units>
                  <Value>5.0</Value>
               </Weight>

Not needed anymore, no replacement

Notes: �If you are using PACKAGE_GROUPS or PACKAGE_SUMMARY in 
this element, please contact your CT representative for the next 
recommended steps.

<TinType>
The <TinType> element is optional and can be used to provide TINs (Tax Information 
Numbers) for Sender, Recipient or Payer.
It has been changed from Tin to Tins (by adding an “s” at the end). Additionally, the values for 
the <TinType> have changed.

Version 7 Version 28 (current)

<Tin>
    <TinType>SSN</TinType>
    <Number>IT_1234567890</Number>
</Tin>

<Tins>
    <TinType>BUSINESS_UNION</TinType>
    <Number>IT_1111111111</Number>
</Tins>

Notes: �Allowed values: EIN | SSM New Values:
BUSINESS_UNION (mainly used in Europe)
BUSINESS_STATE | BUSINESS_NATIONAL | PERSONAL_NATIONAL |  
PERSONAL_STATE

For European shippers, it is recommended to provide the EORI number of the business 
whenever applicable in this field for a smooth customs clearance process. Please use 
“BUSINESS_UNION” to identify this European identification number.
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<RateRequestTypes>
<RateRequestTypes> indicates the type of rates to be returned. Valid values are:

•  LIST — Returns both account-specific (discounted) rates and standard published rates. 
•  �PREFERRED — Returns account-specific rates in the currency specified in the 

<PreferredCurrency> element, if the element is included in the request.
•  NONE — Returns no rates in response.

To receive account-specific rates in your base currency only, do not send this element in the 
request at all.
The previously used value ACCOUNT is no longer valid in the current version (v28).  
For comparable functionality, use PREFERRED.

Version 7 Version 28 (current)

<RateRequestTypes>ACCOUNT</RateRequestTypes> <RateRequestTypes>PREFERRED</RateRequestTypes>

If you wish to have account-specific rates returned in a currency different to the base currency 
of your account, use the new element <PreferredCurrency> to specify the desired currency of 
the rate quote. This may differ from the currency you declare in your ship request.

Version 7 Version 28 (current)

Not available <RequestedShipment>
            <ShipTimestamp>2009-08-12T09:30:47-01:00</ShipTimestamp>
            <DropoffType>REGULAR_PICKUP</DropoffType>
            <ServiceType>INTERNATIONAL_PRIORITY</ServiceType>
            <PackagingType>YOUR_PACKAGING</PackagingType>
            <PreferredCurrency>CAD</PreferredCurrency>
            <Shipper>
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<Terms of Sale>  
if using FedEx-generated commercial/pro forma invoice
When using a FedEx-generated commercial/pro forma invoice, the list of permitted values has 
changed. FedEx recommends the use of Incoterms 2010.

Version 7 Version 28 (current)

Terms of Sale (Incoterms Updates)

<TermsOfSale>xxx</TermsOfSale>

FOB_OR_FCA
CFR_OR_CPT
CIF_OR_CIP

These Incoterms are still supported but must now be specified individually if used. 
Alternatively, the new values of Incoterms 2010 are now available.

The complete list of valid Incoterms supported by FedEx Web Services now is:
FOB
FCA
CFR
CPT
CIF
CIP
DDP
DDU
DAP
DAT
EXW

Notes: �Only applicable when using a FedEx-generated commercial/pro forma invoice

<CustomerInvoiceNumber>  
if using FedEx generated-commercial/pro forma invoice
When using a FedEx-generated commercial/pro forma invoice, the 
<CommercialInvoiceNumber> element has changed. The commercial invoice information now 
needs to be provided in a new <CustomerReferences> element as shown below.

Version 7 Version 28 (current)

     <SpecialInstructions>[Special Instructions Field]</SpecialInstructions>
     <DeclarationStatment>[Declaration Statement]</DeclarationStatment>
     <PaymentTerms>[Payment Terms Field]</PaymentTerms>
     <Purpose>REPAIR_AND_RETURN</Purpose>
     <CustomerInvoiceNumber>[CommercialInvoiceNumber]</CustomerInvoiceNumber>
     <OriginatorName>[OriginatorName]</OriginatorName>
     <TermsOfSale>DDU</TermsOfSale>
</CommercialInvoice>

     <SpecialInstructions>[SpecialInstructions]</SpecialInstructions>
     <DeclarationStatement>[DeclarationStatement]</DeclarationStatement>
     <PaymentTerms>[PaymentTerms]</PaymentTerms>
     <Purpose>REPAIR_AND_RETURN</Purpose>
     <CustomerReferences>
          <CustomerReferenceType>INVOICE_NUMBER</CustomerReferenceType>
                    <Value>111111</Value>
          </CustomerReferences>
     <OriginatorName>[OriginatorName]</OriginatorName>
     <TermsOfSale>DDU</TermsOfSale>
</CommercialInvoice>

Notes: �Only applicable when using a FedEx-generated commercial/pro forma invoice
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<Broker Select Option>
The element <Broker> has been updated. The <Brokers> element has been added as 
mandatory and now encloses the <Broker> element.
An additional mandatory <Type> element has been introduced. The setting for the normal use 
of the BROKER_SELECT_OPTION is IMPORT. 
Exception: If a shipment originates in Mexico, an EXPORT broker can be specified.

Version 7 Version 28 (current)

            <SpecialServicesRequested>

<SpecialServiceTypes>BROKER_SELECT_OPTION</SpecialServiceTypes>
            </SpecialServicesRequested>
            <CustomsClearanceDetail>
               <Broker>
                  <Contact>
                     <PersonName>Mr Broker</PersonName>
                     <CompanyName>Broker Corporation</CompanyName>
                     <PhoneNumber>5556667777</PhoneNumber>
                     <EMailAddress>skjapan@doesnotexist.de</EMailAddress>
                  </Contact>
                  <Address>
                     <StreetLines>Ave de Broker</StreetLines>
                     <StreetLines>Numero 2</StreetLines>
                     <City>BEVERLY HILLS</City>
                     <StateOrProvinceCode>CA</StateOrProvinceCode>
                     <PostalCode>90210</PostalCode>
                     <CountryCode>US</CountryCode>
                  </Address>
               </Broker>

    <SpecialServicesRequested>

<SpecialServiceTypes>BROKER_SELECT_OPTION</SpecialServiceTypes>
            </SpecialServicesRequested>
            <CustomsClearanceDetail>
             <Brokers>
             <Type>IMPORT</Type>
               <Broker>
                  <Contact>
                     <PersonName>Mr Broker</PersonName>
                     <CompanyName>Broker Corporation</CompanyName>
                     <PhoneNumber>5556667777</PhoneNumber>
                     <EMailAddress>skjapan@doesnotexist.de</EMailAddress>
                  </Contact>
                  <Address>
                     <StreetLines>Ave de Broker</StreetLines>
                     <StreetLines>Numero 2</StreetLines>
                     <City>BEVERLY HILLS</City>
                     <StateOrProvinceCode>CA</StateOrProvinceCode>
                     <PostalCode>90210</PostalCode>
                     <CountryCode>US</CountryCode>
                  </Address>
               </Broker>
               </Brokers>

<Dangerous Goods in Excepted Quantities>
The element <DangerousGoodsDetail> has been updated when shipping Dangerous Goods in 
Excepted Quantities. It is no longer required to specify <Accessibility> when using the SMALL_
QUANTITY_EXCEPTION option in the <Options> element.
The <Accessibility> continues to be used to declare accessibility for fully declared Dangerous 
Goods requiring a Dangerous Goods Shipper’s Declaration.

Version 7 Version 28 (current)

<SpecialServicesRequested>
   <SpecialServiceTypes>DANGEROUS_GOODS</SpecialServiceTypes>
     <DangerousGoodsDetail>
        <Accessibility>ACCESSIBLE</Accessibility>
        <Options>SMALL_QUANTITY_EXCEPTION</Options>
     </DangerousGoodsDetail>
</SpecialServicesRequested>

<SpecialServicesRequested>
     <SpecialServiceTypes>DANGEROUS_GOODS</SpecialServiceTypes>
         <DangerousGoodsDetail>
                <Options>SMALL_QUANTITY_EXCEPTION</Options>
          </DangerousGoodsDetail>
</SpecialServicesRequested>

Notes: �It is also possible to specify Dangerous Goods in Excepted Quantities 
as a commodity with zero value – it is recommended to use the 
appropriate flag instead.



FedEx Web Services 2021 – Technical Upgrade Guide 14

<Email Notification>
The optional element <SpecialServiceTypes> EMAIL_NOTIFICATION with the 
<SpecialServicesRequested> at shipment level has now changed to be EVENT_NOTIFICATION. 
This has also resulted in a change to the <EMailNotificationDetail> element:

Version 7 Version 28 (current)

<SpecialServiceTypes>EMAIL_NOTIFICATION</SpecialServiceTypes>
  <EMailNotificationDetail>
    <Recipients>
<EMailNotificationRecipientType>RECIPIENT</EMailNotificationRecipientType>
                     <EMailAddress>email@address.com</EMailAddress>                      
<NotificationEventsRequested>ON_DELIVERY</NotificationEventsRequested>
<NotificationEventsRequested>ON_EXCEPTION</NotificationEventsRequested>                     
<NotificationEventsRequested>ON_SHIPMENT</NotificationEventsRequested>
<NotificationEventsRequested>ON_TENDER</NotificationEventsRequested>
                     <Format>HTML</Format>
                     <Localization>
                        <LanguageCode>EN</LanguageCode>
                     </Localization>
    </Recipients>
  </EMailNotificationDetail>

<SpecialServiceTypes>EVENT_NOTIFICATION</SpecialServiceTypes> 
                <EventNotificationDetail>
                  <EventNotifications>
                     <Role>RECIPIENT</Role>
                     <Events>ON_DELIVERY</Events>
                     <Events>ON_EXCEPTION</Events>
                     <Events>ON_SHIPMENT</Events>
                     <Events>ON_ESTIMATED_DELIVERY</Events>
                     <Events>ON_TENDER</Events>
                     <NotificationDetail>
                        <NotificationType>EMAIL</NotificationType>
                        <EmailDetail>
                           <EmailAddress>email@address.com</EmailAddress>
                           <Name>RECIPIENT NAME</Name>
                        </EmailDetail>
                        <Localization>
                           <LanguageCode>EN</LanguageCode>
                        </Localization>
                     </NotificationDetail>
                     <FormatSpecification>
                        <Type>HTML</Type>
                     </FormatSpecification>
                  </EventNotifications>
               </EventNotificationDetail>

Available Roles:
•	 BROKER
•	 OTHER
•	 RECIPIENT
•	 SHIPPER
•	 THIRD_PARTY
Available Notification Events:
•	 ON_DELIVER
•	 ON_ESTIMATED_DELIVERY
•	 ON_EXCEPTION
•	 ON_SHIPMENT
•	 ON_TENDER
Available Notification Formats:
•	 HTML
•	 TEXT

Version
Only the version ShipRequest (V26) and higher supports the new FedEx Service portfolio. 
Please access the resources at FedEx Web Services | FedEx Developer Resource Center to 
download all relevant documentation and WSDLs (you will need to be logged in first).
Should you encounter issues when moving to the 2021 version of FedEx Web Services,  
do not hesitate to reach out to the FedEx Customer Technology team.

https://www.fedex.com/en-us/developer/web-services/process.html#AdvancedServices
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